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Overview of User Interface



Step-by-Step Guide to Starting a New Project in NVivo

To start a new project:

1. Open the NVivo Application

Launch the NVivo application by
clicking the QSR NVivo icon on your
desktop. When the application opens
for the first time, the NVivo User dialog
box will appear.

2. Update User Information

In the dialog box, the Name field will
display your Windows username by
default. Update this if necessary,
especially if the Windows login is
shared with others, by entering your
own name.

3. Enter Your Initials

Fill in the Initials field with your initials
and click OK to proceed.

4. Create a New Project

On the Welcome screen, click the New
Project button to begin creating your
project.



Step-by-Step Guide to Starting a New Project in NVivo

Completing the New Project Setup in NVivo:

5. Name Your Project

In the New Project dialog box, enter a
name for your project in the Title field.

6. Add a Project Description
(Optional)

If needed, provide a description of
your project in the Description field.
This could include details such as the
objectives of your research project.

7. Choose a Project Location

To change the default location for
saving your project, click the Browse
button and select your preferred
location.

8. Finalize and Open the Project

Click OK to proceed. The NVivo
window will open, displaying your
project name in the Title bar and your
initials in the Status bar.



Types of Nodes in NVivo

Key Types of Nodes in NVivo Explained:

1. Free Nodes

Independent nodes that are not
organized in a hierarchy.

2. Tree Nodes

Parent Nodes: Represent general
categories.
Child Nodes: Represent specific
sub-categories under parent
nodes.

4. Relationships

Nodes that define and describe the
connections between two project
items.

5. Matrices

A set of nodes generated from a
matrix coding query, often used for
comparisons or data summarization.

3. Cases

Nodes used to store demographic or
attribute-related information about
participants or entities.



Three Types of Views

Overview of NVivo Interface Components:

1. Navigation View

Located on the left side of the screen,
this panel allows you to browse and
access your sources and project items.

2. List View

Positioned at the top portion of the
workspace, this section displays a list
of items contained within the sources
or nodes selected in the Navigation
View.

3. Detail View

Occupying the central and lower-right
portion of the screen, this area
displays the content of the selected
sources. It is also where coding occurs.
The Detail View supports multiple
tabs, enabling you to work with
different sources simultaneously. Tabs
are located in the top-left corner of the
Detail View area.



Key Terms in NVivo

Essential Concepts and Tools in NVivo

1. Queries

Queries allow you to explore your data,
uncover patterns, and refine ideas.
They can be saved, re-run with new
data, and used to track changes in
results over time.

2. Models
Models help visualize your project's
structure or findings.

Static Models: Represent your
project at a specific moment in
time.
Dynamic Models: Reflect your
project in real-time, capturing
ongoing developments.

3. Links

NVivo offers several methods for
linking data elements within your
project to enhance organization and
analysis.



Key Terms in NVivo

Linking and Organizing Tools in NVivo

1. Memo Links

Attach memos to sources or nodes to
document related insights or
contextual information.

2. “See Also” Links

Create pointers between content in
sources, nodes, models, or sets to
establish connections.

4. Classifications

Cases: Organize cases by defining
attributes like gender, age, or
location.
Relationships: Define types of
relationships, such as "loves,"
"impacts," "employs," or "is married
to."

3. Annotations

Add notes directly to selected content,
similar to writing in the margins of a
document, to capture comments or
observations.



Understanding Sources in NVivo

Managing Research Materials in NVivo

In NVivo, "sources" refers to the research materials you use for analysis. These materials
can include a wide variety of formats, from handwritten notes to video recordings. After
setting up your project, you can organize and import your data as follows:

1. Import Internals

Primary sources you can directly import into NVivo,
such as:

Documents: Including text files (.txt), rich text
(.rtf), PDFs (.pdf), and Word documents (.doc).
Examples include interview transcripts, emails, or
literature reviews.
Create Documents in NVivo: NVivo allows you
to create and edit documents within the
software. Refer to the help documentation for
further instructions.

2. Create Externals

Use externals to represent files you cannot directly
import, such as:

Handwritten diaries, physical books, or
presentations (e.g., PowerPoint files).
This feature allows you to reference and
organize such sources alongside your digital
materials.



Understanding Sources in NVivo

Supported Media Types in NVivo

1. Video Recordings

NVivo supports various video formats, including
.mpg, .mpeg, .mpe, .wmv, .avi, .mov, .qt, and .mp4.
Examples include:

Interviews or observations captured on video.
Media clips relevant to your research.

2. Audio Recordings

Audio files in formats like .mp3, .wma, and .wav can
be imported. These might include:

Audio interviews or focus group discussions.
Podcasts, music, or other relevant sound
recordings.

3. Pictures

Image files in formats such as .bmp, .gif, .jpg, .jpeg,
.tif, and .tiff can be used. Examples include:

Photographs to elicit participant responses.
Images taken by research participants
themselves.



Introduction to Coding in NVivo

Simplifying the Coding Process in NVivo

1. Basic Coding

Coding helps organize all content related to a
specific topic into one place. By opening a node, you
can view all the references associated with that
topic.

2. Advanced Coding

Use Text Search Queries to locate all instances of a
particular word and code them automatically. For
example, search for occurrences of the word "fun"
and code them under the node Enjoyment.

3. Auto Coding

For structured data like survey responses, NVivo
offers auto-coding features to:

Code by paragraph.
Use paragraph styles or transcript fields for
efficient organization.



Introduction to Coding in NVivo

Steps for Coding Content in a Document

1. Open the Document

Open the document you wish to code; it will appear
in the Detail View.

2. Access Nodes

Open the appropriate node folder to display nodes
in the List View.

5. Create a New Node for Coding

a. On the Coding Toolbar, select Name from the
Code At drop-down menu.
b. Enter a name for the new node in the following
field.
c. Choose a location for the node from the In drop-
down menu.
d. Click the Code button to complete the process.

3. Adjust Views for Coding

If needed, re-arrange the views for convenience:
Go to the View menu, select Detail View > Right.

4. Drag-and-Drop Coding

Highlight the content you want to code.
Drag the selected content to the desired node.

*Viewing Coded Content

Double-click the node to open it and view the coded
content associated with it.



Introduction to Coding in NVivo

Steps for Coding an Audio or Video Source

1. Open the Audio or Video Source

Open the desired audio or video file in NVivo. It will
be displayed in the Detail View.

2. Access Nodes

Open the appropriate node folder to display nodes
in the List View.

4. Code Text in the Transcript

Select a specific row in the transcript and drag it
to the required node.
Alternatively, highlight specific text in the
Content column, right-click, and choose to code
it at a node.

3. Code Directly on the Timeline

Select a portion of the audio or video timeline.
Drag and drop the selected segment onto the
desired node.

*Viewing Coded Content

Double-click on the node to see the segments or
text you have coded.



Exploring Nodes and Advanced Features in NVivo

Opening a Node to View Coded References

1. In Navigation View, click on Nodes.
Once you are familiar with sources, nodes,
and coding, you can explore more
advanced functionalities, including:

2. Select the required node type.

3. In List View, double-click the node
you want to open.

4. The node will appear in Detail View
with the Reference tab displayed,
showing all the coded references.

1. Finding Project Items: Locate specific items
within your project.

2. Querying Your Data: Use queries to analyze
and search through your data.

3. Creating Models: Visualize patterns and
relationships in your project.

4. Creating Charts: Generate charts to represent
data visually.

5. Running Reports: Produce detailed reports
based on your project data.

6. Exporting Data: Export your data for use
outside NVivo.



Finding Project Items in NVivo

Tools for Finding and Filtering Data in NVivo

NVivo offers various tools to help you search and filter your data efficiently.
Utilize the Find feature to locate specific text within a source by selecting
Find from the Edit menu.



Advanced Search in NVivo

Filtering Project Items with Advanced Criteria

Used to filter project items based on specific criteria, such as identifying all
cases involving women or narrowing it down further to women who are over 50
and retired.



Searching All Codes and Cases

Customizing Searches for Codes and Cases

The "Search All Codes and Cases" feature in NVivo allows you to efficiently locate specific
data across various parts of your project. Here's how you can refine your search:

Current Folder: Limits the search to the folder
currently open in your project.

1.

Subfolders: Expands the search to include all
subfolders within the current folder.

2.

Project: Searches the entire NVivo project,
encompassing all folders, files, and nodes.

3.

 All Codes: Focuses the search on all the codes
(nodes) within your project.

4.

All Files: Searches across all files in the project,
including documents, transcripts, and media
files.

5.

Select Folder: Allows you to choose a specific
folder for targeted searching.

6.



Organizing Data with Tree Nodes

Adding Child Nodes Under a Parent Node

To create child nodes under a parent node:

Select Parent Node: Choose the parent node
where the child node will be added.

1.

Access New Node Option: On the Main
Toolbar, click the New button.

2.

Choose Tree Node: Select the Tree Node in this
Folder option to begin creating the child node.

3.

Open New Node Dialog: The New Tree Node
dialog box will appear, prompting you to input
details.

4.

Name and Describe Node: Provide a name and
description for the new child node.

5.

Save Node: Click OK to add the node under
the parent.

6.



Querying Data in NVivo

Using Coding Queries for Targeted Analysis

To create child nodes under a parent node:
Select Parent Node: Choose the parent node where the child node will be added.1.
Access New Node Option: On the Main Toolbar, click the New button.2.
Choose Tree Node: Select the Tree Node in this Folder option to begin creating the child node.3.
Open New Node Dialog: The New Tree Node dialog box will appear, prompting you to input details.4.
Name and Describe Node: Provide a name and description for the new child node.5.
Save Node: Click OK to add the node under the parent.6.

*Repeat these steps to add additional child nodes as needed.



Querying Data in NVivo

Creating a Matrix Coding Query for Comparative Analysis

Generates a matrix of nodes according to specified search criteria. For instance, it can display perspectives on
volunteering categorized by different age groups.



A Compound Query in NVivo is a powerful tool that allows
you to combine text searches with coding queries. This
means you can:

Search for Specific Text: Identify occurrences of a
particular word or phrase within your data.

1.

Search Near Coded Content: Narrow down the search to
locate text that appears in or near content already coded
at specific nodes.

2.

For example, you can use a Compound Query to find
instances where the word "challenge" is mentioned within a
few lines of content coded under the node "Leadership
Issues." This helps refine your analysis by linking textual data
with thematic coding.

 Advanced Querying in NVivo

Combining Text and Coding with Compound Queries



Exploring Data with Queries in NVivo

Leveraging Text Search Queries

A Text Search Query is a tool in NVivo designed to help you locate specific words or phrases across your project data. It is
particularly useful when you need to:

Identify Key Terms: Search for recurring words or concepts in your documents, transcripts, or other sources.1.
Uncover Patterns: Analyze how often and where particular terms are used to gain insights into trends or
themes.

2.

This query provides a straightforward way to explore your data and focus your analysis on specific topics of interest.



Analyzing Patterns in NVivo

Word Frequency Queries

A Word Frequency Query generates
a list of words along with the
number of times they appear in
selected data items. This tool helps
identify recurring terms, providing
insights into potential themes and
key concepts within your project.



Analyzing Data in NVivo

Using Coding Queries

A Coding Query retrieves
content based on how it has
been coded in your project. For
example, you can use this tool to
gather all content where women
discussed personal goals,
helping to focus your analysis on
specific themes.



Visualizing Data in NVivo

Creating Charts

Access Chart Wizard: From the Tools
menu, select Charts to open the Chart
Wizard dialog box.

1.

Choose a Chart Type: Select the type of
chart you want to create and click
Next.

2.

Select Data for the Chart: Choose the
data you wish to include. The available
options will vary depending on the
selected chart type.

3.

Generate the Chart: Click Finish to
create the chart, which will be
displayed in the Detail View.

4.



Generating Insights with Reports in NVivo

Running Reports Step-by-Step

Access Reports: From the Tools
menu, select Reports.

1.

Choose a Report: Pick the specific
report you want to run.

2.

Configure Report Layout: Adjust the
layout options according to your
preferences.

3.

Generate the Report: Click OK to run
the report, which will be displayed in
the Report Viewer.

4.



Project Summary: Provides an overview of the project's
status, listing the items it contains. This summary is helpful
for tracking and communicating your project's overall
progress.

1.

Source Summary: Details the sources in the project,
including the number of nodes that code them. It also
provides additional information such as paragraph and word
counts.

2.

Node Summary: Lists all nodes in the project and indicates
the number of sources coded at each node. This helps
identify themes or ideas that are more prominent within your
data.

3.

Relationship Summary: Organizes relationships by type and
highlights the amount of coding done for each. This provides
insights into the connections and their coding status in your
project.

4.

Summarizing Data in NVivo

Types of Project Summaries



Attribute Summary: Displays a list of attributes
and the number of cases assigned to each
attribute value. This report is valuable for
verifying consistency and ensuring a balanced
project sample.

1.

Coding Summary: Provides a detailed list of
sources along with the nodes that code them.
This is a practical way to monitor the progress
of your coding and can include data coded by
all or selected users.

2.

Running Reports in NVivo

Key Report Types
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